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Safety

 

Definitions and Symbols

WARNING

 

This symbol indicates high voltage. It calls your attention to items
or operations that could be dangerous to you and other persons
operating this equipment. Read the message and follow the
instructions carefully.

 

This symbol is the “Safety Alert Symbol.” It occurs with either of
two signal words: CAUTION or WARNING, as described below.

WARNING

 

Indicates a potentially hazardous situation which, if not avoided,
can result in serious injury or death.

CAUTIONCAUTION

 

Indicates a potentially hazardous situation which, if not avoided,
can result in minor to moderate injury, or serious damage to the
product. The situation described in the CAUTION may, if not
avoided, lead to serious results. Important safety measures are
described in CAUTION (as well as WARNING).

 

Hazardous High Voltage

WARNING

 

Motor control equipment and electronic controllers are connected
to hazardous line voltages. When servicing drives and electronic
controllers, there may be exposed components with housings or
protrusions at or above line potential. Extreme care should be taken
to protect against shock.

Stand on an insulating pad and make it a habit to use only one
hand when checking components. Always work with another
person in case an emergency occurs. Disconnect power before
checking controllers or performing maintenance. Be sure
equipment is properly grounded. Wear safety glasses whenever
working on electronic controllers or rotating machinery. 
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Warnings and Cautions

CAUTIONCAUTION

 

The USB ports are to be used for corrective maintenance only and
not for permanent use in Class I, Div 2 Groups A, B, C, D locations.
If permanent use is required in Class I, Div 2 Groups A, B, C, D
hazardous locations then UL approval must be obtained.

CAUTIONCAUTION

 

Make sure to turn off and/or disconnect power to the PanelMate
ePro PS unit before removing or inserting the CompactFlash
memory card, as the CompactFlash memory card should not be
hot-swapped. Failure to remove power before installing or
removing the CompactFlash memory card, can result in damage to
the CompactFlash and/or unit.

CAUTIONCAUTION

 

Before hot-swapping PCMCIA cards, verify the card being used is
specified to support hot-swapping.

CAUTIONCAUTION

 

Your PanelMate ePro PS unit is equipped with port isolation on
serial port 1 (COM1) only. Check for any ground potential difference
between your communication equipment and your PanelMate ePro
PS unit. If there is a ground potential difference, your
communication equipment will need to be isolated.

CAUTIONCAUTION

 

The CompactFlash card and any PCMCIA card must be removed
before removing the back cover of the unit.

CAUTIONCAUTION

 

Explosion hazard. Substitution of components may impair
suitability for Class I, Division 2.

ADVERTISSMENT

 

Risque d’explosion. La substitution de composants puet rendre ce
material inacceptable pour les emplacements de Classe I, Division 2.

WARNING

 

Explosion hazard. Do not replace components unless power has
been switched off or area is known to be non-hazardous.

ADVERTISSMENT

 

Risque d’explosion. Couper le courant ou s’assurer que
l’emplacement es designe non dangereux avant de replacer le
composants.
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Chapter 1 — Getting Started with the PanelMate ePro PS

 

This chapter provides getting started information.

The following topics are discussed:

 

●

 

Introduction

 

●

 

Unpacking

 

●

 

ePro PS models

 

●

 

Windows XP Embedded (XPE)

 

●

 

Protect Mode

 

●

 

Connectors and Ports
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Introduction

 

The PanelMate ePro PS family is made up of high performance yet cost-effective operator 
interface (OI) products. The ePro PS family carries on the PanelMate tradition of performance 
in balance with ease of use. The ePro PS family sets the standard for hybrid OI systems by 
combining the flexibility of Microsoft’s

 

®

 

 Windows

 

®

 

 XP Embedded operating with the stability 
and reliability achieved through the solid-state hardware design and exclusive Protect 
Mode™ that provides protection for the operating system and software.

The ePro PS family provides the performance and flexibility of PC based operator interfaces 
without the associated complexity of a PC on the plant floor. With integrated high-speed 
Ethernet, serial ports, USB ports, removable CompactFlash

 

®

 

, and PCMCIA slots, the ePro PS 
models can be adapted for a wide variety of user requirements.

The ePro PS family of products are configured with the Canvas

 

®

 

 editing software. The 
Canvas editor supports a modern suite of graphical templates, called controls, for replacing 
hardwired panel devices such as pushbuttons, indicator lights, bars, readouts, message 
displays, etc.

Whether replacing hard-wired pilot devices and pushbuttons or providing machine control 
and even SCADA functions, the ePro PS family of products will fit from both a form and 
functional standpoint.

The PanelMate ePro PS family of products includes:

 

●

 

PanelMate ePro PS

 

●

 

PanelMate ePro PS OD (Outdoor Series)

 

●

 

PanelMate ePro PS EE (Enterprise Edition)

 

●

 

PanelMate ePro PS Classic

A brief description of the OD, EE and Classic models is given below.

Throughout this manual, information provided about the PanelMate ePro PS family will 
apply to all four PS models.

 

ePro PS OD

 

The PanelMate ePro PS OD (Outdoor Series) operator interface is designed for use in outdoor 
applications. The OD models offer increased visibility as well as UV resistance. Reflective 
films behind the display, plus anti-reflective, anti-glare, and anti-UV coatings in front of the 
screen provide superior outdoor viewability without adding active, heat generating 
components to the unit, allowing the OD models to meet high the temperature requirements 
of outdoor applications.

 

ePro PS EE

 

The PanelMate ePro PS EE (Enterprise Editions) operator interface is designed for end-users 
that need more memory or additional Windows XP Embedded components and services to 
support large Canvas applications or third-party software.
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ePro PS Classic

 

The PanelMate ePro PS Classic operator interface is designed for use by end-users that are 
currently using the PanelMate Power Pro software and are ready for the new PanelMate ePro 
PS hardware but are not quite ready to convert their PanelMate Power Pro configurations to 
Canvas applications. Since the PanelMate ePro PS Classic OI supports the PanelMate Power 
Pro and PanelMate ePro PS Runtime software, the user can utilize the PanelMate ePro PS 
Runtime software if and when they are ready.

The ePro PS Classic OI is based on the PanelMate ePro PS hardware models with the addition 
of software and licenses that allow users to run the PanelMate Power Pro Runtime software 
in addition to the three application kits (Document Viewer, Headline Manager and Recipe 
Manager). The ePro PS Classic OI can be thought of as a combination of the PanelMate ePro 
PS and the PanelMate ePro with the XE (without Trending) and the OPC options. One 
difference is in the area of drivers: the ePro PS Classic OI running PanelMate Power Pro 
configurations does not support native (non-OPC) communication drivers but does support 
up to three OPC drivers simultaneously.

 

Unpacking

 

Carefully remove all equipment from the packing cartons and inspect all parts for damage in 
shipment. Check packing cartons for all items shown on the packing list. Keep the cartons 
and packing materials for future shipment.

If there is equipment damage due to shipment, report the damage to the carrier who 
delivered the equipment.

 

Note: 

 

The Interstate Commerce Commission has a time limit on reporting concealed 
damage.

 

Packing List

 

The PanelMate ePro PS units includes the following:

1. Qty 1 — PanelMate ePro PS unit

2. Qty 1 — Accessory kit which includes:

a. Qty 1 — Panel mounting hardware kit (Display models only)

b. Qty 1 — 3-pin power connector

c. Qty 1 — PanelMate ePro PS support CD

d. Qty 3 — Spare jumpers used to configure serial ports

e. Qty 1 — KEPServer_ePro CD-ROM (Classic models only)
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PanelMate ePro PS Models

PanelMate ePro PS display models include an integrated color display. A Blind Node (no 
display) model is available for applications that use external displays. All display models 
feature a resistive touchscreen for operator input.

The PanelMate ePro PS models include:

● 7685T-8 8" TFT display

● 7685T-10 10" TFT display

● 7685ST-10 10" TFT display, stainless steel

● 7685T-12 12" TFT display

● 7685ST-12 12" TFT display, stainless steel

● 7685T-15 15" TFT display

● 7685ST-15 15" TFT display, stainless steel

● 7600 Blind Node

The PanelMate ePro PS OD (Outdoor Series) models include:

● 7685T-8OD 8" TFT display

● 7685T-12OD 12" TFT display

● 7685ST-12OD 12" TFT display, stainless steel

● 7685T-15OD 15" TFT display

● 7685ST-15OD 15" TFT display, stainless steel

The PanelMate ePro PS EE (Enterprise Edition) models include:

● 7685T-8E 8" TFT display

● 7685T-10E 10" TFT display

● 7685ST-10E 10" TFT display, stainless steel

● 7685T-12E 12" TFT display

● 7685ST-12E 12" TFT display, stainless steel

● 7685T-15E 15" TFT display

● 7685ST-15E 15" TFT display, stainless steel

● 7600E Blind Node

The PanelMate ePro PS Classic models include:

● 7685T-8C 8" TFT display

● 7685T-10C 10" TFT display

● 7685ST-10C 10" TFT display, stainless steel

● 7685T-12C 12" TFT display

● 7685ST-12C 12" TFT display, stainless steel

● 7685T-15C 15" TFT display

● 7685ST-15C 15" TFT display, stainless steel

● 7600C Blind Node
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PanelMate ePro PS Classic Documentation References 
The following manuals provide additional information regarding the use of PanelMate Power 
Pro Runtime software:

PanelMate PC Runtime Operation User’s Guide

Describes how to use the PanelMate PC Pro Runtime software.

● Provided on the PMPROSW CD-ROM

PanelMate Document Viewer Users Guide

Describes the Document Viewer and the Application Kit Selector. Important information 
about the PMStart.cmd command file is included.

● Provided on the PMPROSW CD-ROM

PanelMate Headline Manager Users Guide

Describes the Headline Manager and the Application Kit Selector. Important information 
about the PMStart.cmd command file is included.

● Provided on the PMPROSW CD-ROM

PanelMate Recipe Manager Users Guide

Describes the Recipe Manager and the Application Kit Selector. Important information about 
the PMStart.cmd command file is included.

● Provided on the PMPROSW CD-ROM
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Protect Mode

The PanelMate ePro PS family of products has a unique and exclusive Protect Mode feature 
that safeguards the integrity of files stored on the C:\ partition of your operating system. This 
feature ensures that data and operating system files cannot be modified by anyone or 
corrupted by unexpected power disruptions. As a result, you can be confident that the ePro 
PS meets your rigorous industrial environmental requirements and can be protected against 
all unauthorized alterations.

The Protect Mode is always active on your ePro PS unit. As changes are made to data and 
files they appear to be saved but in reality they are saved in volatile memory. This means that 
when the ePro PS is restarted, all of the changes will be deleted from memory and the last 
information saved in the C:\ partition will be used. With this in mind, all changes made that 
are to be stored in the C:\ partition must be saved or committed so that the next time the ePro 
PS is restarted the new data will be available. Types of data stored on the C:\ partition include 
the ePro PS Runtime software, communications drivers, OPC server, time/date data and 
touchscreen calibration data.

Notes: 

● The D:\ partition is reserved for user data and is not protected by the Protect Mode 
feature. Data and program files can be easily added, modified and deleted in this 
storage area. On the Enterprise Edition models the D:\ partition is a separate drive 
located in the External CompactFlash port of the unit. On all other models it is a 
partition on the internal flash drive along with the C:\ partition.

● If extensive changes are made to the C:\ partition without a subsequent reset or 
execution of the Protect Mode Save, volatile memory may become full resulting in 
system errors.

Refer to Protect Mode Save Program on Page 3-5 for additional information about saving 
files to the C:\ partition.

Windows XP Embedded (XPE)

PanelMate ePro PS uses Windows XPE, which is a subset of Windows XP Professional. XPE 
enables PanelMate ePro PS unit’s operating system (OS) to be customized. As a result, 
unneeded OS components have been eliminated resulting in a smaller, streamlined, and 
efficient system. Because XPE allows us to protect the OS from unwanted software changes, 
we can make your ePro PS unit reliable for industrial applications, whereas an open XP 
operating system is susceptible to lockups from OS file corruption. The Enterprise Edition 
models include virtually all Windows XP services and features so that it is compatible with 
virtually all 3rd party software packages.
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Image Loads 

Each PanelMate ePro PS model has an image load that is installed prior to shipment. The 
image load contains the OS and other files dependent on the model type. If desired, the 
image load can be restored to the current factory image load by using a Restore Kit 
accessory. The image load for Enterprise Edition models is different from the one used for 
Standard, Outdoor and Classic models. When restoring an image load it is important that the 
correct load is installed to maintain the integrity of the hardware.

Restore Kits include the following:

● 76MLPS Image Load for PanelMate ePro PS, Outdoor and Classic models

● 76MLEE Image Load for PanelMate ePro PS Enterprise Edition models

Preloaded Software 

The ePro PS models all come with preloaded Eaton software and software licensing. 

All ePro PS models come with the following:

● PanelMate ePro PS Runtime software Not installed Pre-licensed

● KEPServer_ePro OPC Server Pre-installed Pre-licensed

● KEPServer_ePro OPC Drivers Not installed Pre-licensed, Qty 3

● Data Archiving License Pre-licensed

● Recipe Management License Pre-licensed

In order to run a Canvas Runtime application on a new unit or one that has been re-imaged 
refer to Installing Software on Page 2-11 of this manual.

PanelMate ePro PS Classic

The ePro PS Classic includes additional files that support PanelMate Power Pro applications.

The ePro PS Classic models include the following:

● PanelMate PC Runtime software Pre-installed Pre-licensed

● Document Viewer Not installed Pre-licensed

● Headline Manager Not installed Pre-licensed

● Recipe Manager Not installed Pre-licensed

● PMStart.cmd command file Pre-installed No licensing required

Notes:

The unit is shipped so that when powering up for the first time the PanelMate Power Pro 
Document Viewer demo configuration (DVDemo.pps) will be launched via the PMStart.cmd 
command file.

The ePro PS Classic has been pre-configured so that the PanelMate PC Runtime software 
runs in 256 colors compatibility mode so that regardless of the native color resolution of the 
unit, PanelMate’s 256 color palette will still function properly. If you decide to use the 
PanelMate ePro PS Classic hardware for PanelMate ePro PS Runtime applications you will 
not have to change the color resolution of the unit. The PanelMate PC Runtime software is 
also set for VGA compatibility so that when the PanelMate PC application launches the 
displays convert to run full screen at 640x480 resolution and return to native resolution when 
it closes. All ePro PS Classic models have a minimum resolution of 800x600, so that when 
used to run Canvas runtime applications instead of PanelMate PC runtime applications they 
may run at their higher native resolution without the need to alter the display properties. 
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Connectors and Ports

The location of the connectors and ports is shown in Figures 1-1 and 1-2. The Ethernet port 
supports 10/100 communications. All of the USB ports are V2.0 compliant and independent 
so that slow data rate devices such as keyboards and mice will run at their V1.1 speeds 
without impacting the speed of V2.0 devices on other ports.

Note: All installed peripherals (i.e. USB devices, PCMCIA devices, etc.) on the ePro PS unit 
should not consume more than 5 additional watts. Consuming more than this will 
reduce the specified operating temperature of the ePro PS unit.

Figure 1-1: Connector Locations

CAUTION

The USB ports are to be used for corrective maintenance only and
not for permanent use in Class I, Div 2 Groups A, B, C, D locations.
If permanent use is required in Class I, Div 2 Groups A, B, C, D
hazardous locations then UL approval must be obtained.

24V DC — In
Socket (GND - + )

COM1 — RS232/422/485

COM2 — RS232

Video Out (VGA)

LAN (Ethernet)

USB 2.0 (x4)
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Figure 1-2: CompactFlash and PCMCIA Slot Location

CompactFlash Slot

The CompactFlash slot is located on the side of the unit as shown above.

When installing the CompactFlash memory card into the PanelMate ePro PS unit ensure that 
the guides are lined up carefully and the “lip” on the memory card is toward the back of the 
unit.

CAUTION

Make sure to turn off and/or disconnect power to the PanelMate
ePro PS unit before removing or inserting the CompactFlash
memory card, as the CompactFlash memory card should not be
hot-swapped. Failure to remove power before installing or
removing the CompactFlash memory card, can result in damage to
the CompactFlash and/or unit.

Note: ScanDisk CompactFlash memory cards are recommended for use with the PS unit.

PCMCIA Slots

The PCMCIA slots are located on the side of the unit as shown above.

The PCMCIA interface supports up to 2 Type II cards or 1 Type III card. When installing the 
PCMCIA card into the PanelMate ePro PS unit ensure that the guides are lined up carefully 
and the top on the card is toward the back of the unit.

CAUTION

Before hot-swapping PCMCIA cards, verify the card being used is
specified to support hot-swapping.

Note: Although most Windows XP functionality has been included in the ePro PS operating 
system and many devices have been tested and authorized, not all device drivers have 
been included. You may have to install the device drivers provided by the card 
manufacturer.
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Chapter 2 — Preparing the ePro PS for Online Use

This chapter describes how to get started with your ePro PS unit. 

The following topics are discussed:

● Powering up your ePro PS unit

● Preparing your ePro PS unit for online use

● Preparing your ePro PS for file transfers

● Installing software and downloading configurations

● Managing accounts and changing passwords
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Powering Up Your ePro PS Unit

In order to power up your PanelMate ePro PS unit, you need to provide an isolated 4.0 amp 
24-volt power source/supply. Your PanelMate ePro PS unit is designed to operate at 24VDC. A 
removable three-position DC power connector attaches to the unit's connector receptacle. 
(Refer to Appendix B for additional information).

Notes: 

Use #18 AWG (0.82 mm2) copper wire for power and ground lead connections.

Power conditioning may be required when the PanelMate ePro PS unit is installed in areas of 
poor power quality.

The ePro PS unit is designed to operate with a peak inrush current of 8 A, a maximum current 
of 2.25 A, and a maximum power of 54 watts.

Figure 2-1: Powering Up ePro PS Unit

Power and Ground Instructions

The PanelMate ePro PS operator interface has been designed to withstand severe 
environmental conditions typical in industrial installations. However, certain extreme 
conditions, such as serious ground faults, have the potential to damage the PanelMate ePro 
PS operator interface or cause other damage. In all cases, the end user must ensure that the 
installation is protected from these extreme conditions and follows local codes and electrical 
standards and regulations.

The following advice is intended to help protect the PanelMate ePro PS unit from damage 
due to current swells, ground faults, or ground potential differentials that can occur in 
electrical system installations.

● Use an isolated power supply

● Use single point grounding

● Install a power supply solely for the PanelMate ePro PS

● Use a current-limiting power supply

● Add circuit breakers
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Use an Isolated Power Supply

AC to DC power supplies are typically isolated while DC to DC power supplies are often non-
isolated. Check the power supply specifications to ensure that the power supply is fully 
isolated. If used in a Class I, Div 2 environment, then the external power supply must be 
appropriately rated.

Use Single Point Grounding

The external power supply and the PanelMate ePro PS unit should be grounded to the same 
point. Single point grounding should be practiced even when the devices are located in 
separate enclosures to help prevent ground loop issues.

Install a Power Supply Solely for the PanelMate ePro PS

If the current external power supply is used for multiple devices, add an external power 
supply specifically for the PanelMate ePro PS unit. A separate external power supply will 
better protect against system transients and ground potential issues. If used in a Class I, Div 2 
environment, the external power supply must be appropriately rated.

Use a Current-Limiting Power Supply

The external power supply should not be able to source more than five amps. If used in a 
Class I, Div 2 environment, the external power supply must be appropriately rated.

Add Circuit Breakers 

Install circuit breakers (Cutler-Hammer Catalog Number WMS2C04) on both the supply and 
return paths between the PanelMate and the external power supply to protect against current 
swells on the return path. The circuit breakers should be rated for ten amps.

Preparing Your ePro PS Unit for Online Use

You may find it useful during the initial preparation of the ePro PS unit, to connect both a 
USB keyboard and mouse to the unit. After powering up the ePro PS user interface, you can 
connect to it in order to do one or more of the following: 

● Install the latest Canvas Runtime software (included on the Canvas Software CD-ROM)

● Install an OPC driver (included on the Canvas Software CD-ROM)

● Download a Canvas configuration (created using Canvas software)

● Download a PanelMate Power Pro configuration (PanelMate ePro PS Classic users 
only)

Refer to Preparing Your ePro PS for File Transfers on Page 2-6 and Installing Software on 
Page 2-11 for additional information.

Note: PanelMate ePro PS models are pre-licensed to run with the Kepware OPC server and 
drivers. The Kepware OPC server is preinstalled and configured for optimum 
performance. For Canvas applications to run correctly online, it is necessary that the 
OPC drivers are installed or downloaded to the PS unit. Refer to Installing New OPC 
Server and Drivers on Page 2-12 for additional information.



PanelMate® ePro PS Family User Manual

2-4 For more information visit: www.eaton.com MN04801001E

March 2008

Communicating to a PLC or Controller

Your PanelMate ePro PS unit can communicate to a PLC or controller via:

● A serial connection

● An Ethernet connection (Refer to the Connecting to Your ePro PS for Data 
Transfer/Software Downloads section for more information about setting up 
an Ethernet connection)

● An optional interface card

Connecting to the Serial Ports

The external serial ports may be used for communications with a PLC or controller. Serial 
port 1 (COM1) supports RS232 (default), RS422, RS485, and RS485+ communications while 
serial port 2 (COM2) supports RS232 only. Serial port 2 (COM2) is used for the touchscreen 
on the Blind Node models.

Table 2-1: Serial Port Connections 

CAUTION

Your PanelMate ePro PS unit is equipped with port isolation on
serial port 1 (COM1) only. Check for any ground potential difference
between your communication equipment and your PanelMate ePro
PS unit. If there is a ground potential difference, your
communication equipment will need to be isolated.

Pin RS232 RS422 RS485 RS485+

1 DCD, Data carrier detect TX- DATA- DATA-

2 RXD, Receive data TX+ DATA+ DATA+

3 TXD, Transmit data RX+ Do not connect Do not connect

4 DTR, Data terminal ready RX- Do not connect Do not connect

5 Signal Ground Signal Ground Signal Ground Signal Ground

6 DSR, Data set ready Do not connect Do not connect Do not connect

7 RTS, Request to send Do not connect Do not connect Do not connect

8 CTS, Clear to send Do not connect Do not connect Do not connect

9 RI, Ring Indicator Do not connect Do not connect Do not connect
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Setting COM1 Jumpers for RS232, RS422, RS485 or RS485+

Serial port 1, COM1, can be configured to support RS232 (default), RS422, RS485, or RS485+ 
communications by configuring the jumper settings on the board. The board can be accessed 
by removing the back cover of the unit. The location of the jumpers and their proper settings 
are shown below. 

Figure 2-2: Setting COM1 Jumpers for RS232, RS422, RS485 or RS485+

CAUTION

The CompactFlash card and any PCMCIA card must be removed
before removing the back cover of the unit.

Note: Jumpers are included in the Accessory Kit that is provided with each ePro PS unit.
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Preparing Your ePro PS for File Transfers

You can transfer files to the PanelMate ePro PS and download software using the following 
methods:

● An Ethernet connection using static IP addressing, using either

– A point-to-point connection (direct) using a shielded Cat 5 Ethernet crossover cable

– A network connection using a local Ethernet hub/switch and a pair of shielded Cat 5 
Ethernet patch cables

● An Ethernet workgroup or domain on a plant/local network connection with a DHCP 
server assigning the ePro PS’s IP address

● An external drive connected via USB, CompactFlash, or PCMCIA slot

Note: Canvas users transfer files using the Send to File feature which can send directly to an 
ePro PS unit over Ethernet or to a USB memory drive which then can be connected to 
an ePro PS unit for upload/install.

PanelMate ePro PS factory settings are: 

● TCP/IP protocol

● Computer name: EATONxxxxxx (Name is unique for each unit but will begin with 
EATON)

● Workgroup name: WORKGROUP

● IP Address: DHCP

● Subnet Mask: DHCP

Other items to consider when communicating using Ethernet include:

● All static IP addresses must be unique

● All computer names must be unique

● All subnet masks must match

● We recommend that all workgroup names match

● We recommend using a shielded Cat 5 cable for industrial applications
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Connecting to Your ePro PS via the Ethernet

When connecting your ePro PS through any of the following methods, the unit you are 
connecting to should appear in the network neighborhood of a Microsoft operating system. If 
it does not appear in the network neighborhood, use the Find computer or Search computer 
utility to find the desired unit. When searching, you can search by computer name or by the 
unit’s IP address. 

Setting Up a Point-to-Point (Direct) Ethernet Connection

To connect to your PanelMate ePro PS unit using this method, complete the following steps:

1. Use a crossover cable.

2. Connect one end of the cable to the Ethernet port on your computer and the other end 
of the cable to the Ethernet port of your PanelMate ePro PS unit. 

3. Power up your computer and your PanelMate ePro PS unit. 

Result: A green LAN Present LED indicator should appear next to the Ethernet port.

Once you have established the physical connections, the next step is to establish the correct 
logical connections between your computer and your PanelMate ePro PS unit. If you are 
using a static IP address, the computer IP address should be assigned a unique value where 
the first three fields match that of the ePro PS. For example, if the IP address of the ePro PS 
is 192.168.0.001, then the computer IP address would be 192.168.0.xxx where xxx is between 
0 and 255 and is not equal to 001.

Figure 2-3: Point-to-Point Ethernet Connection

Point-to-Point (Direct)

Use Static IP Addressing

Use Crossover Cable
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Setting Up an Ethernet Connection Using a Hub/Switch

This method can be used to set up a local workgroup using only static IP address. To set a 
local workgroup with dynamic only or static and dynamic combined see Setting Up a Local 
Ethernet Workgroup Using DHCP Server. To connect to your PanelMate ePro PS unit using 
this method, complete the following steps:

1. Use patch cables.

2. Power up the hub/switch and connect a patch cable from both your computer’s and your 
PanelMate ePro PS unit’s Ethernet port to the hub or switch. Other units can be added. 

Note: Do not to use the port labeled Uplink on the hub or switch.

Result: A green LAN Present LED indicator should appear next to the Ethernet port on 
each machine.

3. Once you have established the physical connections, the next step is to establish the 
correct logical connections. If you are using a static IP address, the computer IP address 
should be assigned a unique value where the first three fields match that of the ePro PS 
(for example, 192.168.0.xxx where xxx is between 0 and 255 and is not equal to any 
other assigned value).

Notes:

If there are multiple ePro PS units on the network, you will need to make sure the Computer 
Name and IP address on each workgroup unit is unique. 

You can build user accounts and passwords locally on all Windows XP systems when 
managing a local workgroup. Refer to the Managing Accounts and Changing Passwords 
section for more information.

Figure 2-4: Hub/Switch Ethernet Connection

Point-to-Point (Hub/Switch)

Use Static IP Addressing

Use Patch Cables
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Setting Up a Local Ethernet Workgroup Using DHCP Server

Use a DHCP server to set up a local Ethernet workgroup if you are setting up a local network 
using a hub or switch that will not be connected to a larger plant network. 

To connect to your PanelMate ePro PS unit using this method, complete the following steps:

1. Use patch cables.

2. A DHCP router must be used to provide IP addresses to any units that are set up for 
automatic IP addressing. If any units on the local workgroup are set up for static 
addressing the DHCP router must support this as well. In most cases the router must be 
powered up first, before any of the units, so the router can provide any addressing 
needs. Powering the router up after any units are powered on may result in a unit not 
receiving an IP address. Connect the patch cables from the units to the router. 

Result: A green LAN Present LED indicator should appear next to the Ethernet port on 
each machine.

3. Once you have established the physical connections, the next step is to establish the 
correct logical connections. If you are using a static IP address, all other IP addresses 
should be assigned a unique value where the first three fields match that of the ePro PS 
(for example, 192.168.0.xxx where xxx is between 0 and 255 and is not equal to any 
other assigned value).

Notes:

If there are multiple ePro PS units on the network, you will need to make sure the computer 
name and IP address on each workgroup unit is unique. 

You can build user accounts and passwords locally on all Windows XP PC’s when managing 
a local workgroup. Refer to the Managing Accounts and Changing Passwords section for 
more information.

Figure 2-5: Local Ethernet Workgroup Using DHCP Server

Local Network

Dynamic Addressing Only

Use a DHCP Router

Units Set for Automatic IP Address

Use Patch Cables

Local Network

Static and Dynamic Addressing Only

Use a DHCP Router Capable of Static 
addresses

Units Set for Automatic IP Address

Use Patch Cables
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Setting Up PanelMate ePro PS on a Domain Network Using DHCP Server

Working on domain networks is the same as working in a local workgroup. You can use static 
or dynamic addressing (DHCP) to establish a connection to the network. PanelMate ePro PS 
can share information with other units of the same workgroup or other workgroups as long 
as none of the units are logged on to a domain. 

PanelMate ePro PS can connect to resources logged on to a domain by the user supplying a 
valid “domain name”, “user id” and “password” (these are provided by the network 
administrator). This procedure will create a connection to the domain resource that will last 
as long as it is not manually removed or a loss of power to any of the connected devices does 
not occur. 

C / D Partitions

Your ePro PS unit comes with two drive partitions

● C:\ partition

● D:\ partition

Eaton recommends that you use these drives as follows:

Table 2-2: Recommended Drive Use 

Drive Partition Recommended Use

C:\ Use the C:\ partition for software installations, to store all of your programs and 
purchased software. This partition is protected (locked from change), so you 
should use it to store all data on the ePro PS that needs to be protected.
Note: All changes made to the C:\ partition must be saved or committed so that 
the next time the ePro PS is restarted the new data will be available. Refer to the 
Protect Mode Save section for additional information about saving files to the 
C:\ partition.

D:\ Use the D:\ partition to store data that changes on a regular basis, such as 
configuration files.
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Installing Software

Typical data transfers and software downloads may include the following:

● Configuration data files (.ucf files) (.pps files for Classic models only)

● Canvas Runtime software installation

● OPC driver installation

There are two methods for installing authorized software on your PanelMate ePro PS unit:

● Ethernet connection.

Canvas users have the option of using the Send to File feature that manages the 
transfer and installation of files. 

● An external drive connected via USB, CompactFlash, or PCMCIA slot.

Note: All changes made to the C:\ partition must be saved or committed so that the next time 
the ePro PS is restarted the new data will be available. Refer to the Protect Mode Save 
section for additional information about saving files to the C:\ partition.

Types of Software That Can Be Installed

You can install PanelMate ePro PS Runtime software and Kepware OPC servers/drivers on 
your PanelMate ePro PS unit.

The PanelMate ePro PS EE models have a unique image load and hardware configuration 
designed to support the following Eaton and Cutler-Hammer software packages:

● CH Studio

● IProx Development Software

● SVX Drives Software

● ELCSoft, Programming Software

● PowerNet Software

● Power Xpert Software

Other third-party software packages or OPC servers that have not been tested and verified to 
run on the ePro PS may not install or run properly for the following reasons:

● Windows XP Embedded although based on XP Pro, is different from the commercial, 
open, Windows XP Professional operating system. Therefore, some drivers, services 
and support components that other software programs require may not be present in 
the PanelMate ePro PS XP Embedded operating system.

● There may not be enough drive space (non-volatile flash memory) to install or 
configure unauthorized software.

● The ePro PS unit does not support runtime writes to the operating system, C:\ partition. 
Therefore, if a third-party package routinely tried to write log files, temporary files, or 
diagnostics to that partition, it would be redirected to a RAM buffer that could take up 
all available RAM and result in unstable system operation.

The ePro PS flash and RAM memory have been sized for those software packages that have 
been qualified for the unit and have validated their runtime integrity. Based on the reasons 
stated above, Eaton recommends that the user thoroughly test any other software. If you 
choose to install untested software, you will be assuming responsibility for overall system 
integrity and reliability.
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Installing Software Using an Ethernet Connection

Using Ethernet, you can connect your ePro PS unit directly to a PC using either a standard 
Patch 5 crossover cable or through a standalone Ethernet hub or switch. You can also 
connect your ePro PS unit to your company’s Ethernet network (you may need the assistance 
of company IT personnel to establish your ePro PS unit’s IP address if you are not using 
DHCP). See the section that addresses Ethernet connections on Page 2-8.

In either case, to install software using Ethernet, you need to:

● Share a network drive for which your ePro PS unit has access rights.

● Browse to that shared drive from the ePro PS unit using Explorer.

● Run the appropriate software installation setup executable.

Canvas users also have the following option for installing application files (.ucf), ePro PS 
Runtime software and Kepware OPC drivers:

● Configure file transfer options using the Destination tab of the Units Properties dialog 
box.

● Select Send to File.

Installing Software Using an External Drive

To install software using an external drive:

1. Copy any installation files from the installation CD to external drive using a desktop PC 
that has both CD and the external drive support.

2. Power down the ePro PS unit when installing or removing a CompactFlash card.

3. Connect the external drive to your ePro PS unit.

4. Power up your ePro PS unit if necessary.

5. You should see the external drive listed as a Removable Disk in Explorer. 

6. Browse to the drive from your ePro PS unit using Explorer, and run the appropriate 
installation setup executable. 

Installing New OPC Server and Drivers

All units come with the basic KEPServer_ePro OPC server components installed and preset 
for optimum use. The only time you will need to install a new OPC server is if you need to 
upgrade the software. This may be done with a standard install procedure running setup.exe, 
or it can be done using Canvas’s Send to File function. Once you are connected to the 
PanelMate ePro PS unit using an Ethernet connection or external drive, you can install the 
OPC server by navigating to the setup.exe file on the KEPServer_ePro CD-ROM. Follow the 
InstallShield Wizard prompts. Select the Modify option so that the preset server settings are 
maintained. You should also install the necessary OPC drivers at this time by selecting and 
expanding the Drivers folder in the component selection dialog box and checking off only the 
drivers desired.

Note: For Canvas applications to run correctly online, it is necessary that the OPC server and 
drivers installed on the PS unit are the same version as the server and drivers installed 
on the Canvas development PC. For this reason it is recommended that Canvas’s Send 
to File function is used for updating the server or drivers.
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Installing OPC Drivers 

Once you are connected to the PanelMate ePro PS unit using an Ethernet connection or 
external drive, you can install the OPC drivers of your choice by navigating to the setup.exe 
file on the KEPServer_ePro CD-ROM included with the ePro Software Suite or with the 
PanelMate ePro PS Classic unit. Follow the InstallShield Wizard prompts. It is recommended 
that you keep the number of files installed to a minimum by selecting the Modify option, then 
expanding the Drivers folder in the component selection dialog and checking off only the 
drivers desired.

Using Canvas software the user has the option of transferring driver files to the PanelMate 
ePro PS unit using the Send to File feature.

Downloading and Running a Canvas Configuration (.ucf File)

Once you are connected to the PanelMate ePro PS unit using an Ethernet connection or 
external drive, you can set up the unit to run your Canvas application by using the following 
steps:

1. Copy your Canvas configuration file (.ucf file) to the shared application directory (D:\cfg) 
of the ePro PS using Explorer. If you are using an Ethernet connection, you may initiate 
the copy from your development PC or from the ePro PS unit, assuming the 
configuration is located in a shared network drive or directory. 

OR

Using Canvas software the user may transfer files over an Ethernet connection using 
the Send to File feature. When using Send to File, a modified eProStart.cmd file is 
automatically transferred to the D: folder.

2. If the Copy method was used in Step 1 above you will need to modify the eProStart.cmd 
file located under the root directory of D: by changing the line set 
MY_CFG=d:\cfg\Myconfig.ucf to match the location and name of your Canvas 
configuration filename.

3. Your Canvas application will automatically launch each time your ePro PS reboots.

To launch your Canvas application manually, use the eProStart shortcut off the Windows 
Start menu.

Note: If you decide to use your PanelMate ePro PS Classic hardware to run PanelMate 
ePro PS applications it is recommended that you change the value that launches 
D:\PMStart.cmd in the registry key:

HKEY_LOCAL_MACHINE \Software\Microsoft\Windows\CurrentVersion\Run\ …

… to launch the D:\eProStart.cmd command file instead. You will also want to change the 
shortcut in the Windows Start menu to point to the eProStart.cmd command file instead of 
PMStart.cmd. The eProStart shortcut is located at C:\Documents and 
Settings\Administrator\Start Menu. Open the properties of the shortcut and change the 
Target to: D:\eProStart.cmd.
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Downloading and Running a PanelMate Power Pro Configuration (.pps File)

PanelMate Power Pro Configurations can be used with the Classic models only.

Once you are connected to the PanelMate ePro PS Classic unit using an Ethernet connection 
or external drive, you can set up the unit to run your PanelMate Power Pro configuration by 
following these steps:

1. If you are copying a pre-existing PanelMate Power Pro configuration that used the 
KEPServer_EX OPC server to the ePro PS Classic then you will need to modify the 
PanelMate Power Pro configuration PLC Name and Port Table. The ePro PS Classic uses 
the KEPServer_ePro OPC server. As a result, you will need to change the Server Name to 
EatonElectrical.KEPServer_ePro.

2. Copy the PanelMate Power Pro configuration file (.pps file) to the D:\cfg of the ePro PS 
Classic using Windows Explorer. If you are using an Ethernet connection, you may 
initiate the copy from your development PC or from the ePro PS Classic unit, assuming 
the configuration is located in a shared network drive or directory.

3. Modify the PMStart.cmd file located under the root directory of D:\ by changing the line 
set MY_CFG=d:\cfg\Myconfig.ucf to match the location and name of your PanelMate 
Power Pro configuration file.

4. Your PanelMate Power Pro configuration will automatically launch each time your ePro 
PS Classic reboots.

To launch your PanelMate Power Pro configuration manually, use the eProStart shortcut off 
the Windows Start menu.

Converting a Power Pro Configuration and Running on the ePro PS Classic

The following is a step by step process for converting a Power Pro configuration to a 
PanelMate PC configuration and getting it to run on the ePro PS Classic:

1. Import the .PPS file to PanelMate Power Pro editor (File > Import)

2. Convert the Model to PanelMate PC Pro (File > Convert)

3. Convert communications setup from PanelMate’s native driver in the PLC Name & Port 
Table to OPC Server and change the Server Name property of the PLC device to 
EatonElectrical.KEPServer_ePro, and add the access path (ChannelName.DeviceName) 
Note: See following section on Addressing Differences between Kepware and Power 
Pro Drivers

4. Export to new .PPS file name (File > Export). Note: Do not use “File > Export As”

5. Copy new .PPS and .OPF files to the ePro PS unit to “D:\Cfg” directory

6. Edit D:\PMStart.cmd and point MyCfg = to the path and name of the PPS file

7. Install KEPServer_ePro on the ePro PS unit, choose Modify from Upgrade, Modify, 
Remove selection and select the correct driver from the driver list to install (copy the 
install CD to USB memory stick or browse to a shared drive with the install files over 
Ethernet).
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8. Open KEPServer_ePro and set the Default project to the new OPF file. (Tools > Options … , 
General Tab, Default Project property), then close KEPServer_ePro

9. Perform a Protect Mode Save operation (Start > ePro Manager, Protect Mode Save tab, 
Commit)

10. Connect communications cable. At minimum you will need the male ‡ female 9 pin 
adapter which comes with the ePro PS Classic unit for a serial cable connection or you 
may need a new serial cable. By default the PLC manufacturer’s serial programming 
cable will work with the ePro PS Classic.

11. Go on line and debug. Note: the configuration should start automatically after the 
Protect Mode Save operation and reboot.

Addressing Differences between Kepware and Power Pro Drivers

There are some differences between address syntax used in PanelMate Power Pro drivers 
and Kepware’s OPC drivers. The following guidelines should be considered when converting 
between the two.

● For Allen Bradley SLC 500 or PLC-5 applications, if you are referencing local I/O 
addresses you must fill out the I/O Slot configuration for the PLC in the Device 
properties of KEPServer_ePro.

● For Allen Bradley SLC 500 or PLC-5 serial (DF1) driver PanelMate always used BCC 
error checking. Kepware allows you to choose between BCC and CRC so you should 
use BCC unless you make the change to the PLC using the RSLogix programming 
software.

● If using non default data types that required casting operators in PanelMate (Eg. 
Modicon Floating Point values with #FP, any String values with #ASC20, etc.) you must 
create a tag in KEPServer_ePro to represent the address and assign the correct data 
type to the tag. Then change PanelMate’s address to refer to the Kepware tag (Eg. 
[plc1,tag]).

● Remember, Kepware’s address syntax requirements overrule Power Pro syntax – most 
drivers are identical, but if in doubt refer to Kepware’s driver help files to make sure.
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Troubleshooting Communications and Startup Problems

The following section describes common problems and their possible solutions when 
converting a Power Pro configuration to a PanelMate PC configuration, using 
KEPServer_ePro, to run on an ePro PS Classic unit.

Table 2-3: Troubleshooting 

Symptom Possible Cause(s) Corrective Action

No data is showing up and 
you are not getting 
communications errors.

The OPC Setup information 
was not entered correctly in 
the PLC Name and Port Table.

Check that the OPC Server name is: 
EatonElectrical.KEPServer_ePro; and 
make sure the access path is spelled 
correctly.

The File >Export As function 
was used for the PPS file 
generation. This strips out 
any OPC setup entries.

Re-export using the File >Export 
function in Power Pro software.

The OPC Server is not 
installed on the ePro PS unit 
or the correct driver or drivers 
were not installed.

Check the server and driver installation.

The OPC Server has the 
wrong default project 
selected.

Open Kepware and verify that your OPF 
file will open and that it is the default 
project and remember to do a Protect 
Mode Save if the default project is 
changed or if a the OPC server or driver 
is updated or installed.

No data is showing up and 
you are getting 
communications errors.

Improper cable, port, or 
Kepware setup.

Check Kepware to verify you are using 
the correct serial port on the ePro PS.

Make sure the cable pinouts are 
correct — see the Kepware driver help 
file for cable pinouts (may not be the 
same as the Power Pro with a male 
female gender changer).

Check Kepware setup and verify all 
settings, then test with their OPC Quick 
Client and verify that data quality is 
good for the PLC’s access path 
(_System paths will always show good 
data). If no tags are configured create 
tags in the Quick Client to read known 
good addresses. If Kepware’s Quick 
Client cannot read data from the PLC 
neither will PanelMate.

Some data is displaying 
correctly but you are getting 
communications errors on 
some of the addresses.

Improper Slot configuration 
for AB PLC’s.

If you are trying to read local I/O in an 
AB SLC or PLC-5 you need to correctly 
set up the Slot Configuration tab of the 
device properties in Kepware.

Non-default data format 
casting operators (#FP, #ASC, 
etc.) are not understood by 
Kepware.

PanelMate formats for non-default data 
types are not understood by the 
Kepware driver. You should create tags 
in Kepware for these addresses and 
define the data type in the tag, then use 
the tag instead of the address inside of 
the square brackets in PanelMate (Eg. 
[PLC1, tagname]).
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Uninstalling Software

All software should be removed using the Add or Remove Programs utility located in the 
Control Panel.

Note: All changes made to the C:\ partition must be saved or committed so that the next time 
the ePro PS is restarted the new data will be available. Refer to the Protect Mode Save 
section for additional information about saving files to the C:\ partition.

Uninstalling Touchscreen Drivers

PanelMate ePro PS Blind Nodes include an ELO touchscreen driver, assigned to COM2 by 
default, that loads automatically at startup. If your attached monitor uses something other 
than an ELO touchscreen driver, you will need to uninstall its driver using the Add or Remove 

Programs utility located in the Control Panel. 

The demo application or 
some other application is 
starting instead of the one 
you want; or no application 
starts and it boots into the 
ePro’s desktop.

The PMStart.cmd file isn’t 
configured to run the correct 
PPS file or you copied the 
wrong PPS file to the ePro, or 
the PMStart.cmd file was 
deleted.

Edit the PMStart.cmd file on the D:\ 
drive and verify that MyCfg = is set to 
the correct file name.

Copy the PPS file back to your PC and 
import it into the PanelMate editor to 
see if you have the correct file on the 
ePro unit. 

If the PMStart.cmd file does not exist 
you must reload it.

The ePro PS unit does not 
boot up to Windows.

The power supply is 
insufficient for the ePro PS 
(white or black screen).

The 8" requires 1.3 amps, the 
10" 1.4 amps, the 12" 1.5 amps the 
15" 2.25 amps, and the blind node 
1.0 amps. The peak inrush is 7.0 amps 
for all except the 15" which is 8.0 amps.

The Operating System has 
become corrupted.

Losing power during a Protect Mode 
Save or performing a Protect Mode 
Save after installing bad software or 
being exposed to a virus or other 
malware could corrupt the OS. If this 
happens a “Restore to Factory Image” 
procedure needs to be performed.

Remove all devices and try re-booting.

A device is installed in a USB 
port, PCMCIA slot, or external 
CompactFlash drive that is 
affecting proper startup.

Hook up an external monitor to ePro’s 
VGA port to determine if it is only a 
backlight failure then contact Eaton 
Electrical’s service and repair 
department at (920) 262-3645.

Note: Backlights are field replaceable 
with the proper kit from service.

The display or backlight has 
failed so that you can’t see 
that it is running properly or a 
hardware failure requires the 
unit be repaired.

Table 2-3: Troubleshooting (Continued)

Symptom Possible Cause(s) Corrective Action
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Managing Accounts and Changing Passwords

There is an account set up on your PanelMate ePro PS unit when it was shipped from the 
factory; the Administrator account. The password for the Administrator account is 
Administrator. 

Notes: 

● ePro PS passwords are case sensitive.

● ePro PS account names are not case sensitive.

The ePro PS is set up to automatically log in to the Administrator account, which is why the 
normal Windows XP Security dialog box does not appear upon bootup.

If you are connecting your PanelMate ePro PS unit to a larger network, you might want to 
modify the Administrator account name and password to protect the ePro PS unit from 
unauthorized access.

Modifying an Account Name and Password

You can modify the Administrator and any other account name password from the User 
Accounts utility in the Control Panel. 

Once the Administrator password has been successfully modified you must follow the How 
to Disable/Change the Auto Logon Feature section in order to continue to automatically log in 
to the Administrator account at bootup.

Note: All changes made to the C:\ partition must be saved or committed so that the next time 
the ePro PS is restarted the new data will be available. Refer to the Protect Mode Save 
section for additional information about saving files to the C:\ partition.

Using the Auto Logon Feature

The ePro PS Auto Logon feature is used to automatically log into a specified account name 
and password. By default, the Auto Logon feature is enabled and logs into the Administrator 
account, using Administrator as the account name and password.

If you want to change the Auto Logon features, refer to the descriptions below.

Note: You must have administration privileges in order to disable/change the Auto Logon 
feature.
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How to Disable/Change the Auto Logon Feature

To disable or change the Windows XP Auto Logon feature you will need to know how to edit 
the Windows XP registry using Regedit. Extreme care should be exercised when making 
changes to the Windows XP registry. If you are not familiar or comfortable making changes 
to the registry, contact your local system or network administrator.

The following entries in the Windows XP registry can be modified to change the account, 
password, and domain used by the Auto Logon Feature:

\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Winlogon\DefaultUserName

\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Winlogon\DefaultPassword

\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Winlogon\DefaultDomain

To enable/disable the Auto Logon Feature, set the following registry entry to 1 or 0:

\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\ 
Winlogon\AutoAdminLogin

Setting Up PanelMate ePro PS on a Domain Network 

PanelMate ePro PS can function on domain networks as either a workgroup member or as a 
domain member. If PanelMate ePro PS is configured as a workgroup member (default 
setting) it can share information with other units of the same workgroup or other workgroups 
as long as none of the units are logged on to a domain. 

As a workgroup member PanelMate ePro PS can connect to domain resources or map shared 
network drives on the domain by having the user supply a valid “domain name”, “user id” 
and “password” (these are provided by the network administrator). This procedure will 
create a connection to the domain resource that will last as long as it is not manually 
removed or power is lost, or the connection to a connected device does not occur. If a 
connection to a domain resource is required at all times, such as after a system restart, and 
you don’t want to have to re-enter a user name and password each time, the following lines 
can be added to the eProStart.cmd file located on the ePro’s D:\ partition. 

Add these lines to create an automatic connection that is not assigned a drive letter: 

Add these lines to create an automatic connection that is assigned a drive letter: 

NET USE /PERSISTENT:NO

NET USE \\BIGSERVER /USER:MYPLANT\JAMESB agent007

NET USE /PERSISTENT:NO

NET USE X: /D

NET USE X: \\BIGSERVER\SECRETS /USER:MYPLANT\JAMESB agent007
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Where: 

For a second example where: 

Then the following lines would be added to the eProStart.cmd file: 

PanelMate ePro PS is factory set as a workgroup member but may be configured to a domain 
network through the System icon in Control Panel, or “My Computer > Properties”. If the unit 
is a domain member then security and share access is managed by the domain’s 
administrator and the ePro can automatically receive share privileges when it logs on to the 
domain.

X Desired drive letter to be assigned 
BIGSERVER Domain resource being connected to 
SECRETS Folder on domain resource to connect to 
MYPLANT Domain name 
JAMESB User ID 
agent007 = Password 

M Desired drive letter to be assigned 
MKESVR1 Domain resource being connected to 
EPRO_ARCH Folder on domain resource to connect to 
NASA Domain name 
E0011987 User ID 
CKm2_548#6L Password 

NET USE /PERSISTENT:NO

NET USE M: /D

NET USE M: \\MKESVR1\EPRO_ARCH /USER:NASA\E0011987 CKm2_548#6L
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Chapter 3 — Software Tools, Utilities and Programs

This chapter describes how to use a variety of system software tools, utilities and programs 
that make the hardware perform as desired.

The following topics are discussed:

● Screen Brightness and Backlight Auto-Dimming

● Protect Mode Save Program

● Calibrating the Touchscreen

● Changing the Screen Resolution
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Introduction

The PanelMate ePro PS operator interface has several software tools, utilities and programs 
to help keep the system running smoothly. 

Figure 3-1: ePro PS Boot-up Desktop

Status Bar Icons

There are several icons that show up in the status bar: 

Tap this icon to change the Screen Brightness and Backlight Auto-Dimming.

Tap this icon to bring up a menu which will allow you to set the color and screen 
resolution of the display or to open display properties.

Double-tap the time/date values to access the Time-Date program.
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Screen Brightness and Backlight Auto-Dimming

PanelMate ePro PS units with 8", 10", 12" or 15" displays have a screen brightness utility that 
allows you to set the screen brightness and to configure the backlight auto-dimming feature. 
The backlight auto-dimming feature allows you to reduce the brightness of the backlight 
when the unit is not being used which in turn will extend the life of the display backlight.

Notes:

● The PanelMate ePro PS backlight life is calculated with the Screen Brightness setting at 
the midpoint level. 

● The PanelMate ePro PS Blind Node does not support the Screen Brightness nor the 
Backlight Auto-dimming features. Screen brightness will be controlled using tools 
provided with the display.

The screen brightness utility loads automatically at startup and an icon is placed in the 
system tray in the lower-right corner (by the clock) of the display. To set the screen brightness 
or to configure the auto-dimming feature, select the icon in the system tray.

You will be presented with a Screen Lightness control. Move the selector to the desired 
lightness level. 

Note: When adjusting the Screen Lightness, you may come across a setting which makes a 
high pitched noise or makes the screen flicker. These are normal characteristics of 
fluorescent lighting and will not harm the unit itself. Adjusting the setting up or down 
slightly will eliminate the flicker or noise. 

Figure 3-2: Screen Lightness Adjustment
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To configure the backlight auto-dimming feature select the Configure button. You will see the 
LCD Dimming Configuration dialog box as shown on the following figure. First configure the 
idle time wait period (specified in seconds) as desired. When the idle time wait period is set 
to 0 the backlight auto-dimming feature will not be activated and the display will stay at a 
constant brightness. Otherwise, when the unit has been idle (no mouse, keyboard or 
touchscreen input) the designated amount of time, the screen brightness will change to the 
configured setting. Once there is input from a mouse, keyboard or the touchscreen, the 
display brightness will be immediately reset to the default setting.

Next, slide the selector box (or if a USB keyboard is attached, use the left and right cursor 
keys on the keyboard) to set the desired screen lightness level to be used after the idle time 
has been reached. It is recommended that the lightness be reduced to a level that allows the 
operator to see at least a faint image of the information on the screen. Then hit the OK 
button.

Note: When adjusting the screen lightness for the backlight auto-dimming feature, you may 
come across a setting which makes a high pitch noise or makes the screen flicker. 
These are normal characteristics of fluorescent lighting and will not harm the unit 
itself. Adjusting the setting up or down slightly will get rid of the flicker or noise. 

Figure 3-3: Dimming Control

Note: All changes made to the C:\ partition must be saved or committed so that the next time 
the ePro PS is restarted the new data will be available. Refer to the Protect Mode Save 
section for additional information about saving files to the C:\ partition.

Note: When the screen goes into auto-dimming mode any mouse or touchscreen activity will 
restore the screen to its nominal brightness with no action taken from the mouse click 
or touch make/break by the Canvas application. So you don’t need to worry that an 
operator will accidentally start or stop something or change pages when the screen is 
in the auto-dimming mode.
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Protect Mode Save Program

The PanelMate ePro PS unit is always in Protect Mode which means that the unit is protected 
against unwanted changes to data stored on the C:\ partition. In order to save desired data 
changes to the C:\ partition the Protect Mode Save function must be utilized.

It is good practice to shutdown and restart the ePro PS in preparation to making permanent 
changes to the C:\ partition. This step will ensure that all data stored in volatile memory is 
cleared so that no unexpected corruption or changes will take place on your C:\ partition. 
Once the ePro PS has been restarted, make your changes and then save the changes by 
selecting Start > ePro Manager, go to the Protect Mode Save tab, and click on Commit.

Once the Protect Mode Save program has been launched, the changes that affect the 
C:\ partition will be saved and then the ePro PS unit will automatically shutdown and restart 
in Protect Mode.

Calibrating the Touchscreen

The PanelMate ePro PS units are always in Protect Mode. This means that new calibration 
values will NOT be saved but will be in effect only until the unit is restarted. In order to save 
new calibration values you must run the Protect Mode Save program. If you do not perform 
this step, the ePro PS will revert back to the last saved calibration settings when restarted.

Refer to the Protect Mode section above for additional information.

Calibrating Display Models 

PanelMate ePro PS units with 8", 10", 12" or 15" displays include a PenMount touchscreen 
driver that loads automatically at startup. If you need to re-calibrate the touchscreen, you can 
do so by going to Start > Programs > PenMount USB Utilities > Touchscreen Control Panel to 
launch the calibration program. Once it launches you will see the following PenMount 
Control Panel dialog box (after you select the Calibrate tab).

Figure 3-4: PenMount Control Panel
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While in your normal operating position, select the Standard Calibration button on the 
Calibrate tab and then proceed to touch the red squares as directed. The squares will appear 
at the top, right, bottom, left and central-area of the screen.

Note: The red square at the bottom of the screen will not be visible but the arrow will be 
partially drawn, this is normal operation. Select a point closest to the end of the arrow.

If the calibration is acceptable, select the OK button or the exit shortcut button (X) at the top 
of the window to temporarily save the new calibration. If the calibration is not correct, 
reselect Standard Calibration and repeat the operation until satisfied.

If desired, you can select the Advanced Calibration button. This feature will let you select the 
number of calibration points and provide a display of the calibration data for increased 
accuracy.

Calibrating Blind Node Models

PanelMate ePro PS Blind Nodes include an ELO touchscreen driver that loads automatically 
at startup. If for some reason you find it necessary to re-calibrate the touchscreen, you can do 
so by selecting Start > Settings > Control Panel and then selecting the ELO Touchscreen 
program. Doing so launches the ELO Touchscreen Properties dialog box. Select Calibrate in 
the General tab to start the calibration process.

Note: On the General tab, the Touchscreen Port will have a default value of COM2. While 
COM1 is normally recommended for serial PLC communications because it is optically 
isolated and selectable between RS-232/422/485, if you are not using it for a serial 
communications driver you may choose to use it as the touchscreen port. If so, select 
COM1 for the touchscreen.

Once you start the calibration process, a crosshair on a red and white target appears in the 
upper-left corner of the display. While in your normal operating position, touch the crosshairs 
in the middle of the target. The crosshairs will move to the lower-right corner of the display. 
Touch the crosshairs again, and the crosshairs will move to the upper-right corner of the 
display. After touching the upper-right crosshairs, a Check Calibration dialog box will appear, 
informing you that you have 30 seconds to confirm the calibration. Touch points on the 
screen to confirm the arrow cursor is tracking as desired and then select YES (if the 
calibration does not look correct then select NO and re-calibrate the screen until you are 
satisfied). Once you select YES, you are returned to the ELO Touchscreen Properties dialog 
box. Close the ELO Touchscreen Properties dialog box by selecting the OK button. The 
calibration settings will be temporarily saved at this time.

Close the Control Panel window by selecting the exit shortcut button (X) at the top of the 
window.



PanelMate® ePro PS Family User Manual

MN04801001E For more information visit: www.eaton.com 3-7

March 2008

Changing Screen Resolution

PanelMate ePro PS Blind Node models are preset for 800x600 (SVGA) screen resolution. The 
screen resolution can be changed using the standard Windows Display utility from the 
Control Panel or by clicking the icon in the Windows system tray. 

Note: The PanelMate Power Pro Runtime software requires the unit be at 640x480 VGA 
resolution, however, the PanelMate PC application is set to run in Compatibility mode 
at VGA resolution with 256 colors to support the required resolution and custom 
PanelMate color palette. Therefore you can leave the ePro Classic unit at its native 
display resolution which will automatically switch when you are running the 
PanelMate PC software and return to native resolution when not running it.

Note: If you wish to change the screen resolution to VGA 640 x 480 go to the Display utility in 
Control Panel, select the settings tab, and click on the Advanced button. On the 
resultant dialog box, choose the Adapter tab and click on the List All Modes button and 
select one of the 640 by 480 options. Then click all the OK buttons (3 total) until the 
Display utility closes.

Once you have changed the screen resolution you will need to permanently save the 
information to the C:\ partition. Refer to Protect Mode Save Program, on Page 3-5, for 
additional information about saving settings.
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Chapter 4 — Hardware Installation

This chapter describes how to install your PanelMate ePro PS unit.

The following topics are discussed:

● Safety Considerations

● Installation best practices

● Enclosure selection

● Serial communication cable selection, shielding, grounding and termination

● Serial cable segregation and placement
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Safety Considerations

This equipment is suitable for Class I, Division 2, Groups A,B,C,D or non-hazardous locations 
only.

CAUTIONCAUTION

Explosion hazard. Substitution of components may impair
suitability for Class I, Division 2.

ADVERTISSMENT

Risque d’explosion. La substitution de composants puet rendre ce
material inacceptable pour les emplacements de Classe I, Division 2.

WARNING

Explosion hazard. Do not replace components unless power has
been switched off or area is known to be non-hazardous.

ADVERTISSMENT

Risque d’explosion. Couper le courant ou s’assurer que
l’emplacement es designe non dangereux avant de replacer le
composants.

Installation Best Practices

1. Never use foreign objects to activate the touchscreen. Use a hand, gloved hand or 
stylus. Foreign objects (such as a screwdriver) may cause damage to the touchscreen or 
scratch the front panel reducing visibility of the display.

2. Use a light touch to activate the touchscreen. Touchscreen activation does not require 
the same force necessary to activate a mechanical switch.

3. Disconnect this equipment from the power outlet before cleaning. Use a damp cloth. Do 
not use liquid or spray detergents for cleaning.

4. Do not remove or insert the CompactFlash memory card while the PanelMate ePro PS 
unit is powered up. Doing so may cause damage to the CompactFlash memory and/or 
processor board.

5. Keep this equipment away from condensing humidity.

6. Put this equipment on a reliable surface during installation. Dropping it or letting it fall 
may cause damage.

7. The openings on the enclosure are for air convection cooling. Protect the equipment 
from overheating. DO NOT COVER THE OPENINGS.

8. Always install the unit in a vertical orientation for proper cooling.

9. Make sure the voltage of the power source is correct before connecting the equipment 
to the power outlet.

10. Position the power cord so that people cannot step on it. Do not place anything over the 
power cord.

11. All cautions and warnings on the equipment should be noted.
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12. Never pour any liquid into an opening. This may cause fire, electrical shock and 
equipment failure. And avoid electrically conductive materials (nuts, washers, metal 
filings, etc.) from entering the unit through the openings in the card cage as they could 
cause damage to the processor board.

13. Never open the equipment. For safety reasons, the equipment should be opened only 
by qualified service personnel.

14. If one of the following situations arises, get the equipment checked by service 
personnel:

a. The power cord or plug is damaged.

b. Liquid has penetrated into the equipment.

c. The equipment has been exposed to moisture.

d. The equipment does not work well, or you cannot get it to work according to the 
user’s manual.

e. The equipment has been dropped and damaged.

f. The equipment has obvious signs of breakage.

Enclosure Selection

Enclosure Rating

The front panels of PanelMate ePro PS units provide a Type 4, 4X, 12 and IP65 installation 
rating when mounted in a correspondingly rated enclosure. Make sure the enclosure that you 
choose meets or exceeds your application’s rating requirement.

Enclosure Construction

It is recommended that the enclosure is constructed of cold rolled steel. This type of 
enclosure helps guard your unit against electromagnetic interference, and provides proper 
structural support and good heat dissipation.
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Enclosure Sizing and Unit Positioning

Careful enclosure sizing is important for proper heat dissipation and easy installation and 
maintenance. For efficient convection cooling, clearance space is needed around the ePro PS 
unit and the unit should be mounted in a vertical position. Convection cooling draws a 
vertical column of air upward over internal circuitry through the vents in the unit. In all 
installations, the cooling air must not exceed the maximum specified ambient temperature. 
This determination must be made for the maximum expected plant temperature (maximum 
temperature of the air surrounding the enclosure).

● Maintain recommended clearance space above and below the ePro PS unit (refer to the 
following table for details).

● Avoid mounting other heat-generating equipment near the ePro PS unit. If no 
other location is available, mount the equipment beside or behind the ePro PS unit. 
If side/rear space is not available, it is preferable to mount the other equipment above 
rather than below the ePro PS unit. Be sure to maintain the recommended clearance 
space area between the ePro PS unit and the other equipment.

● Leave room for easy access to circuit boards, wiring and cable connections, and for 
regular maintenance.

Figure 4-1: Unit Mounted in Cabinet with Clearance Space
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Recommended Clearance and Maximum Operating Temperature

The table below provides the recommended clearance and maximum operating temperature 
figures for your ePro PS unit.

Note: The clearance is the space between the ePro PS unit’s electronics and the top or 
bottom of the enclosure.

Table 4-1: Recommended Clearance and Maximum Operating Temperature 

If the inside temperature of the enclosure is above the PanelMate ePro PS unit’s 
recommended range, you must use filtered fans, heat exchangers, or air conditioners to 
lower the temperature. Because hot air rises to the top of an enclosure, the temperature 
inside can vary greatly from bottom to top. A fan can be used to circulate air within the 
enclosure to maintain a more uniform temperature.

Note: If an air-purged enclosure is used, it is recommended that the inside/outside pressure 
differential not exceed 0.5 PSI.

The following sizing table is offered as an aid in the selection of enclosures to be used with 
the PanelMate ePro PS unit. Eaton offers no guarantee or warranty to the specific 
applicability of this table as actual conditions may vary and methods of the use of our 
products are beyond our control. For specific information about enclosure selection and 
cooling methods, contact your enclosure vendor.

Refer to Appendix A for details about the unit and cutout dimensions.

8" Display Models 

Table 4-2: Enclosure Selection — 8" Display Models

10" Display Models

Table 4-3: Enclosure Selection — 10" Display Models

Models
Maximum Operating 
Ambient Temperature Maximum Unit Heat Output

Recommended 
Clearance

All PS 
Models

60°C 31W – 8" Display Model
33W – 10" Display Model
35W – 12" Display Model
54W – 15" Display Model
24W – Blind Node Model

4" minimum

Enclosure Size
Average Internal Temperature Rise 
at Rated Heat Output

16 x 20 x 6 11.5°C

20 x 20 x 6 9°C

20 x 24 x 6 8°C

20 x 24 x 8 6.5°C

Enclosure Size
Average Internal Temperature Rise 
at Rated Heat Output

20 x 20 x 6 9.5°C

20 x 24 x 6 8.5°C

20 x 20 x 8 8°C

20 x 24 x 8 7°C
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12" Display Models

Table 4-4: Enclosure Selection — 12" Display Models

15" Display Models

Table 4-5: Enclosure Selection — 15" Display Models

Blind Node Models

Table 4-6: Enclosure Selection — Blind Node Models

Notes:

● These tables are based on the following assumptions:

– No additional peripherals are installed

– Enclosure is fabricated from cold rolled steel

– All sides of the enclosure are non-insulated (free standing)

– Recommended minimum clearance between the PanelMate ePro PS unit and the top 
and bottom of the enclosure

– No other heat-generating equipment is installed in the enclosure

– Maximum CPU usage

● The temperature rise shown represents the temperature rise in the enclosure above the 
outside temperature. For example: if the temperature outside the enclosure is 35°C and 
the temperature rise in the enclosure is 10°C, then the average temperature inside the 
enclosure will be 45°C. Keep in mind that there will be areas warmer than the average 
inside the enclosure.

Enclosure Size
Average Internal Temperature Rise 
at Rated Heat Output

20 x 20 x 6 10.5°C

20 x 24 x 6 9.5°C

20 x 20 x 8 9.5°C

20 x 24 x 8 8°C

Enclosure Size
Average Internal Temperature Rise 
at Rated Heat Output

20 x 24 x 6 12.5°C

20 x 20 x 8 12°C

20 x 24 x 8 10°C

24 x 24 x 8 9.5°C

Enclosure Size
Average Internal Temperature Rise 
at Rated Heat Output

16 x 20 x 4 9.5°C

16 x 20 x 6 9°C

20 x 20 x 6 6.5°C

20 x 24 x 6 6°C
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Serial and Ethernet Communication Cable Selection, Shielding, Grounding and 
Termination

A variety of communication interface options are available for the ePro PS unit. These 
options include:

● RS232 communications (COM1, COM2)

● RS422/485/485+ (COM1)

● Ethernet communications

No specific communications option is recommended. Your choice should be based on the 
requirements of your entire control system. The communications option that you choose 
determines the precautions that you need to take when installing and connecting your 
PanelMate ePro PS unit.

For easy reference, this section contains a summary of several popular communication 
interface options. Each summary provides specific recommendations, guidelines and 
installation tips.

Note: Low signal level conductors (Category 2) have a low tolerance for induced electrical 
noise. Electrical noise can cause a wide range of communications problems resulting 
in slow or error-prone PanelMate ePro PS operation. Follow all of the installation 
recommendations for the communication option that you choose. Also, follow good 
wiring placement practices as outlined in the Serial and Ethernet Cable Segregation 
and Placement section.

RS232 Communications (COM1, COM2)

Table 4-7: Cable Selection — RS232

RS232 Grounding Recommendations

Grounding of the communication cable shield at both ends provides the most immunity to 
high frequency electrical interference. However, the introduction of low frequency 
interference by high ground currents in the shield may require grounding only one end. 
Should this approach result in unacceptable high-frequency interference, then an RS422 
interface should be considered.

Recommended 
Distance

Recommended Cable 
Type/Size

Up to 50 feet 24 gauge, shielded pair
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RS232 Shielding Recommendations

Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT 
Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. An unshielded line is not recommended because 
the unshielded connectors may act as an antenna resulting in radiated emissions that may 
exceed the CE specification limit. Additionally, shielded cable provides greater ESD 
protection. The shield should be connected directly to the chassis of the interconnected units 
at both ends. The connector housing should contact the cable shield uniformly around the 
entire 360-degree periphery of the housing cable entry opening. Never connect the shield by 
way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield 
should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units (one end only). Never connect the shield by way of 
a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be 
terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad 
capacitor at the other end to the chassis of the second unit. The connector housing should 
contact the cable shield uniformly around the entire 360-degree periphery of the housing 
cable entry opening. Attaching the capacitor at the ac-coupled end requires some ingenuity 
to achieve a secure connection at both the shield and chassis while keeping the capacitor 
lead length as short as possible.
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RS422 Communications (COM1)

Table 4-8: Cable Selection — RS422

RS422 Grounding Recommendations

This balanced interface operates with common mode DC or peak AC voltage differential of 
-7 to +7 volts between grounds at each end of the cable. In cases where the common mode 
voltage approaches either extreme, the system may operate properly when the shield is 
grounded at only one end of the cable. However, this arrangement makes the system 
susceptible to high frequency interference. If the systems do not operate properly due to high 
frequency interference and grounding the cable shield at both ends is ineffective, then total 
isolation must be considered or ground potentials in your plant eliminated. 

RS422 Shielding Recommendations

Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT 
Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. An unshielded line is not recommended because 
the unshielded connectors may act as an antenna resulting in radiated emissions that may 
exceed the CE specification limit. Additionally, shielded cable provides greater ESD 
protection. The shield should be connected directly to the chassis of the interconnected units 
at both ends. The connector housing should contact the cable shield uniformly around the 
entire 360-degree periphery of the housing cable entry opening. Never connect the shield by 
way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield 
should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units (one end only). Never connect the shield by way of 
a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be 
terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad 
capacitor at the other end to the chassis of the second unit. The connector housing should 
contact the cable shield uniformly around the entire 360-degree periphery of the housing 
cable entry opening. Attaching the capacitor at the ac-coupled end will require some 
ingenuity to achieve a secure connection at both the shield and chassis while keeping the 
capacitor lead length as short as possible.

Recommended 
Distance

Recommended Cable 
Type/Size

Up to 4000 feet 22 gauge, shielded pair

Up to 2000 feet for 
RS422 connected 
to A-B Channel 0
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RS485 Multi-Drop Communications (COM1)

Table 4-9: Cable Selection — RS485

This network is an extension of RS422 and is used for the distribution of data between 
multiple system components and peripherals over distances up to 4000 feet. This system will 
tolerate common mode voltage differentials from -7 to +12 volts. For more information refer 
to EIA RS485 Standard below.

RS485 Shielding Recommendations

Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT 
Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. An unshielded line is not recommended because 
the unshielded connectors may act as an antenna resulting in radiated emissions that may 
exceed the CE specification limit. Additionally, shielded cable provides greater ESD 
protection. The shield should be connected directly to the chassis of the interconnected units 
at both ends. The connector housing should contact the cable shield uniformly around the 
entire 360-degree periphery of the housing cable entry opening. Never connect the shield by 
way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield 
should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units (one end only). Never connect the shield by way of 
a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield should be 
terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality shielded cable consisting of twisted pairs for the required communication 
wires and logic common is recommended. The shield should be connected directly to the 
chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad 
capacitor at the other end to the chassis of the second unit. The connector housing should 
contact the cable shield uniformly around the entire 360-degree periphery of the housing 
cable entry opening. Attaching the capacitor at the ac-coupled end will require some 
ingenuity to achieve a secure connection at both the shield and chassis while keeping the 
capacitor lead length as short as possible.

Recommended 
Distance

Recommended Cable 
Type/Size

Up to 4000 feet 22 gauge, shielded pair

Up to 2000 feet for 
RS485 connected 
to A-B Channel 0
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Ethernet Communications

Table 4-10: Cable Selection — Ethernet

Ethernet Shielding Recommendations

Application: Short or Long Runs in LOW or HIGH Noise Environment with INSIGNIFICANT 
Levels of Low Frequency Ground Differential Voltage Between Connected Units

A good quality CAT 5 STP cable is recommended. A CAT 5 UTP cable is not recommended 
because the unshielded cable and connectors may act as an antenna resulting in radiated 
emissions that may exceed CE specification limit. Additionally, STP cable provides greater 
ESD protection. The shield should be connected directly to the chassis of the interconnected 
units at both ends. The connector housing should contact the cable shield uniformly around 
the entire 360-degree periphery of the housing cable entry opening. Never connect the shield 
by way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield 
should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in LOW Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality CAT 5 STP cable is recommended. The shield should be connected directly to 
the chassis of one of the interconnected units (one end only). Never connect the shield by 
way of a drain wire pigtail unless absolutely necessary. If a pigtail is required, the shield 
should be terminated as closely as possible to the connector to minimize the pigtail length.

Application: Short or Long Runs in HIGH Noise Environment with HIGH Levels of Low 
Frequency Ground Differential Voltage Between Connected Units

A good quality CAT 5 STP cable is recommended. The shield should be connected directly to 
the chassis of one of the interconnected units and ac-coupled through a 0.01 microfarad 
capacitor at the other end to the chassis of the second unit. The connector housing should 
contact the cable shield uniformly around the entire 360-degree periphery of the housing 
cable entry opening. Attaching the capacitor at the ac-coupled end will require some 
ingenuity to achieve a secure connection at both the shield and chassis while keeping the 
capacitor lead length as short as possible.

Recommended 
Distance

Recommended Cable 
Type/Size

Install in 
compliance with 
IEEE 802 
Standards

CAT 5, STP 
(Shielded Twisted Pair)
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Serial and Ethernet Cable Segregation and Placement

Serial and Ethernet Cable Segregation

The low power cabling used for PLC and PC-based control systems is very susceptible to 
electrical noise generated by high power conductors. Even when protected by conduit, noise 
can interfere with your communication lines and networks. Therefore, it is important to 
segregate conductors according to their type.

Table 4-11: Serial and Ethernet Cable Segregation 

Cable Placement

The following guidelines should be used when installing your communication cables:

● All Category 2 cables should be shielded and routed in a separate conduit or raceway 
from Category 1 cables.

● Route Category 2 cables at least one foot from 120V AC power lines.

● Route Category 2 cables at least two feet from 240V AC power lines.

● Route Category 2 cables at least three feet from 480V AC power lines.

● Route Category 2 cables at least five feet from high voltage enclosures.

● If a Category 2 cable must cross Category 1 cables, it should cross at a right angle. 
(No parallel runs).

● If Category 2 cable is enclosed in metal conduit or a metal raceway, electrical continuity 
must be maintained along the entire length of the conduit/raceway installation, 
including entry into the enclosure.

● Best Practice: When products that require a supply voltage of 220V AC or Higher are 
mounted within the ePro PS enclosure, the use of a grounded metal divider for 
isolation is recommended.

Category Description Examples

Category 1 High Power Conductors

These conductors can cause electrical noise 
in Category 2 conductors when in close 
proximity. Are more tolerant of electrical 
noise than Category 2.
Reference: NEC article 725 class 1
Reference: IEEE level 3 and 4

AC power lines
High power digital AC and DC lines
Typically these conductors are used to 
Connect hard-contact switches, relays, 
solenoids, motors, generators and arc 
welders.

Category 2 Low Signal Level Conductors

These conductors are less tolerant of 
electrical noise; however, they cause less 
noise in adjacent conductors.
Reference: NEC article 725 class 2, class 3
Reference: IEEE level 1 and level 2

Communication cables—Ethernet, PLC 
networks, etc.
Low power digital AC and DC I/O lines
Typically these conductors are used to 
Connect PLC’s and related modules with 
PanelMate ePro PS’s
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Potential Problem Areas

The following are potential problem areas that might be encountered when installing your 
communication cables:

● High and low power conductors routed in the same conduit or raceway.

● Conduit with low power conductors routed in close parallel proximity to conduit 
containing high power conductors.

● Cable or PanelMate ePro PS unit located too close to devices generating high levels of 
magnetic or electrical interference.

● Lack of continuous electrical continuity along the length of the conduit installation.
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Chapter 5 — Troubleshooting

This chapter describes PanelMate ePro PS troubleshooting.

The following topics are discussed:

● System errors

● Checking user configuration compatibility

● Saving your PanelMate ePro PS system changes
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ePro PS Troubleshooting

The following table provides issues, possible causes and corrective actions for ePro PS 
troubleshooting.

 

Table 5-1: Troubleshooting 

Symptom Possible Cause(s) Corrective Action

Changes made were lost after 
reboot.

Protect Mode Save was not 
run after system changes 
were made.

Make sure that Protect Mode Save is 
run after system changes are made.

The mouse does not work. The mouse:
• Is not plugged in.
• Is disabled.
• Conducted and radiated 

electrical noise is causing 
the mouse to malfunction 
when online.

Make sure that the mouse is plugged in.
Remove or isolate noise source.

The ePro PS displays a “DISK 
BOOT FAILURE, INSERT 
SYSTEM DISK AND PRESS 
ENTER” message.

Call technical support.

During bootup (and 
subsequent bootups), a blue 
screen displays.

Call technical support.

A domain error is received 
when powering up PanelMate 
ePro PS.

Domain configured 
incorrectly.

Check Domain and Network settings.

Screen is flickering. Readjust the Screen Brightness or 
Backlight Auto Dimming.

Unit is making a high pitch 
noise.

Readjust the Screen Brightness or 
Backlight Auto Dimming.

Recommended ScanDisk 
CompactFlash configured as 
a bootable device, does not 
boot.

Call technical support.
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Appendix A — Unit Dimensions

This chapter describes the unit dimensions.
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PanelMate ePro PS 8" Display Models Unit Dimensions

Figure A-1: PanelMate ePro PS 8" — Approximate Dimensions in Inches (mm)

Torque Requirements: 5 inch lbs. for #6-32 nuts

This drawing is available in .dwg format on the Eaton Electrical Internet site 
(www.EatonElectrical.com).
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PanelMate ePro PS 10" Display Models Unit Dimensions

Figure A-2: PanelMate ePro PS 10" — Approximate Dimensions in Inches (mm)

Torque Requirements: 6 inch lbs. for #8-32 nuts

This drawing is available in .dwg format on the Eaton Electrical Internet site 
(www.EatonElectrical.com).
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PanelMate ePro PS 12" Display Models Unit Dimensions

Figure A-3: PanelMate ePro PS 12" — Approximate Dimensions in Inches (mm)

Torque Requirements: 15 inch lbs. for #10-32 nuts

This drawing is available in .dwg format on the Eaton Electrical Internet site 
(www.EatonElectrical.com).
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PanelMate ePro PS 15" Display Models Unit Dimensions

Figure A-4: PanelMate ePro PS 15" — Approximate Dimensions in Inches (mm)

Torque Requirements: 17 inch lbs. for #10-32 nuts

This drawing is available in .dwg format on the Eaton Electrical Internet site 
(www.EatonElectrical.com).
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PanelMate ePro PS Blind Node Models Unit Dimensions

Figure A-5: PanelMate ePro PS Blind Node — Approximate Dimensions in Inches (mm)

This drawing is available in .dwg format on the Eaton Electrical Internet site 
(www.EatonElectrical.com).
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Appendix B — Specifications

This chapter describes the product specifications.
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PanelMate ePro PS Specifications

8" Display Models

● 8.4 inch (213 mm), color TFT display, 16 Million colors

● Resolution: SVGA (800 x 600)

● Brightness: 400 nits, OD Model 425 nits

● Backlight: Field replaceable, 50,000 hours typical life

● Auto dimming

10" Display Models

● 10.4 inch (260 mm), color TFT display, 16 Million colors

● Resolution: SVGA (800 x 600)

● Brightness: 420 nits

● Backlight: Field replaceable, 50,000 hours typical life

● Auto dimming

12" Display Models

● 12.1 inch (307 mm), color TFT display, 16 Million colors

● Resolution: SVGA (800 x 600)

● Brightness: 450 nits, OD Model 505 nits

● Backlight: Field replaceable, 50,000 hours typical life

● Auto dimming

15" Display Models

● 15.0 inch (381 mm), color TFT display, 16 Million colors

● Resolution: XGA (1024 x 768)

● Brightness: 250 nits, 600 nits 15" OD

● Backlight: Field replaceable, 50,000 hours typical life

● Auto dimming

Blind Node Models

● Resolution: VGA (640 x 600), SVGA (800 x 600), XGA (1024 x 768), 

● SXGA (1280 x 1024), UXGA (1600 x 1200)

● Colors: 16 Million colors (SXGA & UXGA — 65K colors)

Operator Entry

Touchscreen interface with resistive technology for gloved hand operation.

Pop-up, on-screen window for alphanumeric keypad support.
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Hardware

● Single piece design for easy panel mounting (except blind node)

Table B-1: Hardware Specifications — PanelMate ePro PS 

Memory

PS, OD, and Classic Models: 

● 512MB DDR2 RAM, 1GB internal CompactFlash (C and D drive)

EE Models: 

● 1 GB DDR2 RAM, 4GB internal CompactFlash (C drive), 512MB external CompactFlash 
(D drive)

All Models: 

● External CompactFlash card slot, USB and PCMCIA ports available for 
additional memory

Voltage

● 24V DC nominal (16 – 30V DC)

Power Consumption/Heat Output

● 8" Models 31 Watts (105 BTU/Hour)

● 10" Models 33 Watts (113 BTU/Hour)

● 12" Models 35 Watts (120 BTU/Hour)

● 15" Models 54 Watts (184 BTU/Hour)

● Blind Node Models 24 Watts (82 BTU/Hour)

Current

● 8" Models 1.3 A

● 10" Models 1.4 A

● 12" Models 1.5 A

● 15" Models 2.25 A

● Blind Node Models 1.0 A

Model Number
Overall Dimensions
H x W x D

Cutout Dimensions
H x W Weight

8" Models 7.63 x 10.51 x 3.90 in
(194 x 267 x 99 mm)

6.50 x 9.38 in
(165 x 238 mm)

6.0 lbs
(2.73 Kg)

10" Models 12.00 x 12.30 x 3.90 in
(305 x 312 x 99 mm)

11.02 x 11.40 in
(280 x 289 mm)

10.5 lbs
(4.77 Kg)

12" Models 11.60 x 15.90x 3.90 in
(295 x 404 x 99 mm)

10.12 x 14.34 in
(257 x 364 mm)

13.0 lbs
(5.91Kg)

15" Models 13.50 x 18.60 x 4.00 in
(343 x 472 x 102 mm)

12.05 x 17.01 in
(306 x 432 mm)

17.0 lbs
(7.73 Kg)

Blind Node Models 9.30 x 12.00 x 3.60 in
(236 x 305 x 91 mm)

Designed for mounting in a 
cabinet

4.5 lbs
(2.05 Kg)
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Peak Inrush Current

● 8" Models 7.0 A

● 10" Models 7.0 A

● 12" Models 7.0 A

● 15" Models 8.0 A

● Blind Node Models 7.0 A

Installation Rating

All ePro PS display models are approved for use in Type 4, 4X, 12 installations and is 
designed to meet IP65 when properly mounted in a correspondingly rated enclosure

System Ambient Temperature

All Models

● Operating: 32 – 140°F (0 – 60°C)

● Non-operating: -13 – 158°F (-25 – 70°C)

System Vibration

● Operating: 1G from 5 – 500 Hz

● Non-operating: 1G from 5 – 500 Hz

System Shock

All Models

● Operating: 100 G

● Non-operating: 100 G

Relative Humidity

● Operating: 20 – 95% non-condensing

● Non-operating: 20 – 95% non-condensing

Altitude

● Operating: 10,000 ft Above Sea Level (3,048 m)

● Non-operating: 40,000 ft Above Sea Level (12,192 m)

Emissions

● CISPR 11 Class A-Radiated and Conducted

Noise Immunity

● IEC 61000-4-2, 3, 4, 5, 6, 8, 11

Agency Certifications

● RoHS

● CE Mark

● UL/cUL and CSA Class I, Div 2, Groups A,B,C,D
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Appendix C — Index

Accounts and Passwords, 2-18

Auto Logon Feature, 2-18
How to Disable/Change, 2-19

Auto-dimming, 3-3
Icon, 3-2

Backlight, 3-3

C/D Partitions, 2-10

Canvas Configuration (.ucf File)
Downloading and Running, 2-13

Catalog Numbers, 1-4

Classic Models, 1-3
Documentation, 1-5
Preloaded Software, 1-7

COM1, 1-8
Jumpers for RS232 or RS422-485, 2-5

COM2, 1-8

Communicating to a PLC or Controller, 2-4

CompactFlash, 1-9

Connecting to the Serial Ports, 2-4

Connectors and Ports, 1-8

Documentation
ePro PS Classic, 1-5

EE Models, 1-2

Enclosure
Construction, 4-3
Rating, 4-3
Selection, 4-3
Sizing, 4-4
Unit Positioning, 4-4

Enclosure Size
8" Display Models, 4-5

10" Display Models, 4-5
12" Display Models, 4-6
15" Display Models, 4-6
Blind Node Models, 4-6

ePro PS Classic, 1-3

Ethernet
Connecting using a Hub/Switch, 2-8
Connecting via the Ethernet, 2-7
Domain Networks Using DHCP 

Server, 2-10
Local Workgroups Using DHCP 

Server, 2-9
Point-to-Point (Direct) Connection, 2-7
Port Location, 1-8
Shielding, 4-11

Ethernet Cables
Grounding, 4-7
Placement, 4-12
Problem Areas, 4-13
Segregation, 4-12
Selection, 4-7
Shielding, 4-7
Termination, 4-7

Hardware Installation Best Practices, 4-2

Icons, 3-2

Image Loads, 1-7
Restoring, 1-7

Installation Best Practices, 4-2

Installing Software, 2-11
.pps Files, 2-14
.ucf Files, 2-13
OPC Drivers, 2-13
OPC Server, 2-12
Types of Software, 2-11
Using an External Drive, 2-12
Via an Ethernet Connection, 2-12

Maximum Operating Temperature, 4-5

OD Models, 1-2

OPC Drivers, Installing, 2-13

OPC Server, Installing, 2-12

Operating Temperature, Maximum, 4-5
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Packing List, 1-3

PanelMate Power Pro Configuration 
(.pps File), 2-14

Downloading and Running, 2-14

Partitions, 2-10

PCMCIA, 1-9

Ports and Connectors, 1-8

Power and Ground Instructions, 2-2

Power Supply, 2-2

Powering Up Your ePro PS Unit, 2-2

Preloaded Software, 1-7

Preparing Your ePro PS for Data 
Transfer/Software Downloads

wnloads, 2-6

Protect Mode, 1-6, 3-5

Recommended Clearance, 4-5

Repair Services, iv

Resolution, Changing, 3-7

RS232
Grounding, 4-7
Shielding, 4-8

RS422
Grounding, 4-9
Shielding, 4-9

RS485
Shielding, 4-10

Safety Considerations, 4-2

Screen Resolution, Changing, 3-7

Serial Cables
Grounding, 4-7
Placement, 4-12
Problem Areas, 4-13
Segregation, 4-12
Selection, 4-7
Shielding, 4-7
Termination, 4-7

Serial Ports
Locations, 1-8

Specifications, B-2

Status Bar Icons, 3-2

Steps to Preparing Your ePro PS Unit for 
Online Use, 2-3

Support Services, iii

Time/Date Setting, 3-2

Touchscreen
Calibrating Blind Node Models, 3-6
Calibrating Display Models, 3-5
Calibration, 3-5
Calibration Icon, 3-2
Uninstalling Touchscreen Drivers, 2-17

Troubleshooting, 5-2

Uninstalling Software, 2-17

Unit Dimensions
8" Display Models, A-2

10" Display Models, A-3
12" Display Models, A-4
15" Display Models, A-5
Blind Node Models, A-6

Upgrade Services, iv

USB, 1-8

Windows XP Embedded (XPE), 1-6
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